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C H A P T E R  1

Installing Meeting Maker Calendar

This chapter contains information about installing Meeting Maker 
Calendar on your computer.

Topics include:

About this Book

Overview

Before You Install

Installing Meeting Maker Calendar

After You Install
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About This Book

About This Book
This book is intended for new users of Meeting Maker Calendar. 

This book contains information on installing, launching, configuring, 
and signing into Meeting Maker Calendar and HTML Calendar

It contains introductory information on using Meeting Maker Calendar 
and HTML Calendar. For more complete instructions on using 
Meeting Maker, see the Meeting Maker Calendar online help, or the 
HTML Calendar online help

Overview
Meeting Maker is a group scheduling tool that makes it easy to 
schedule meetings, plan activities, keep a prioritized to do list, manage 
contacts, and coordinate your calendar with others.

Meeting Maker is a networked software application. The Meeting 
Maker Server stores users' information centrally and relays needed 
information instantaneously between Calendar applications. 

When your Meeting Maker administrator has informed you how 
Meeting Maker Calendar will be distributed, you can install the 
application.

To use Meeting Maker Calendar after you install it, you must configure 
your server information so that Meeting Maker Calendar can find the 
Meeting Maker Server. You can then sign in to your account.

Before You Install
Before you install Meeting Maker Calendar on your machine, make 
sure that your computer meets the Meeting Maker system 
requirements and that it is connected to your network. 
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Meeting Maker Calendar Requirements
Meeting Maker Calendar requires the following hardware and software 
for a minimum installation.

Note: If you want to synchronize Meeting Maker with a Palm 
device, you must also install the Palm Desktop software 
before you install Meeting Maker Calendar. See the Meeting 
Maker Install Guide for details.

Hardware/Software
Windows® 
Requirements

Macintosh® 
Requirements

Operating System Windows 98, Windows 
2000, or Windows XP

OS X

Disk 15 MB free disk space 15 MB free disk space

Network Protocol TCP/IP or SSL TCP/IP or SSL
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Additional Requirements
The Meeting Maker Conduits for Palm devices require this
hardware and software:

Palm OS handheld device

Palm Desktop 4.0 or higher

Download Palm Desktop Software
Download the current version of the Palm Desktop software 
at http://www.palm.com/support/downloads/. 

Tip: If the above link does not work, go to http://
www.palm.com and navigate to the downloads page.
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Configuration Information
Make sure that you have the following information ready so that you 
can sign in after you install. If your administrator has not filled in this 
information for you in the table below, you can print this page, fill in 
the table, and keep it for future reference.

You do not need this information to install Meeting Maker, but you 
need it to sign in for the first time. After the first time you sign in, you 
only need your sign in name and password.

Note: Your Meeting Maker administrator may have created a custom 
installer to preconfigure some of this information for you. If 
so, you may not need all of the above information.

Installing Meeting Maker Calendar
You can install Meeting Maker Calendar on Windows or Macintosh. 
The installation process differs depending on your operating system, 
whether you have Palm Desktop installed, and whether you have a 
previous version of Meeting Maker on your machine. 

Make sure that you meet all hardware and software requirements 
before installing. For more information, see “Meeting Maker Calendar 
Requirements,” above.

Note: If you want to install the Meeting Maker Conduits for Palm 
Devices, you must install the Palm Desktop software before 
you install Meeting Maker. See the Meeting Maker Install 
Guide for details.

What You Need Your Information

Your Meeting Maker sign in name

Your Meeting Maker password

Network Protocol (TCP or SSL)

Your Meeting Maker server name

DNS names or IP addresses of all 
host machines running Meeting 
Maker servers in your environment
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Before You Install

Before You Install
Before you install Meeting Maker Calendar, perform these tasks:

Verify that your computer meets the installation requirements

Connect the computer to your Meeting Maker network.

Sign in Information
Make sure you have the following information ready when you sign in 
to Meeting Maker for the first time. After initial sign in, you need just 
your sign in name and password.

Meeting Maker sign in name and password (if any)

Correct network protocol (TCP or SSL) to select at configuration

Meeting Maker server name

DNS names or IP addresses of host machines running Meeting 
Maker servers

Synching with a Palm Device
To synchronize Meeting Maker with a Palm device, you must
install the Palm Desktop software before you install Meeting Maker 
Calendar.

Installing Meeting Maker Calendar
The installation process differs depending on your operating system, 
whether you have Palm Desktop installed, and whether you have a 
previous version of Meeting Maker on your machine. 

Make sure that you meet all hardware and software requirements 
before installing.

Note: If you want to install the Meeting Maker Conduits for Palm 
Devices, you must install the Palm Desktop software before 
you install Meeting Maker. See Chapter Four of this guide for 
details.
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Installing Meeting Maker on Windows
1. Double-click the Setup.exe file.

Note: The file name may differ if you are installing from a file 
server. See your Meeting Maker administrator.

The Meeting Maker Setup dialog box appears.

2. Click Next.

The Destination Location dialog box appears.

3. Select the desired location, and click Next.

If Palm Desktop software is detected, choose your 
installation option:

• Meeting Maker Calendar

• Conduits for Palm devices - synchronizes with Palm devices

• Meeting Maker Calendar and Conduits

The Installation Complete dialog box appears.

4. Select the readme and auto-launch settings, and click Finish.

Depending on the auto-launch settings, Meeting Maker may 
launch, display the readme file, or the Getting Started Guide. 

Existing Meeting Maker installation
If a previous version of Meeting Maker exists on your computer, the 
Local Data Options dialog box appears. Select from these options:

Move local Meeting Maker database – Creates local data backup

Delete local Meeting Maker data – Deletes local data

Do not move or delete Meeting Maker local data – Overwrites 
local data with current Meeting Maker server data at sign in.
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Installing on Macintosh
1. Double click the file Installer.

The Choose Install Folder window appears.

2. Select the desired location, and click Next.

The Choose Alias Folder window appears.

If Palm Desktop software is detected, a prompt appears to select 
Conduits to install. 

Note: The conduits synchronize your Meeting Maker calendar with 
your Palm device.

3. Select the Calendar alias location, and click Install.

Meeting Maker installs and creates the desired alias. 

The Install Complete window appears.

4. Select the desired readme and auto-launch settings, and click 
Done.

5. Select the readme and auto-launch settings, and click Finish.

Depending on the auto-launch settings, Meeting Maker may 
launch, create a desktop alias, display the readme file, or the 
Getting Started Guide. 

Installation is complete.

Existing Meeting Maker installation
If a previous version of Meeting Maker exists on your computer, the 
Backup Data dialog box appears. Select from these options:

Copy Meeting Maker data – Creates local data backup

Delete Meeting Maker data – Deletes local data

Do nothing – Overwrites local data with current Meeting Maker 
server data at sign in.

After You Install
Once you install Meeting Maker, you can launch and configure 
Meeting Maker. You can then sign in to your account and begin 
working.



    15

 CHAPTER 1: Installing Meeting Maker Calendar

Launching Meeting Maker
You can launch Meeting Maker Calendar on Windows or Macintosh. 
You can also configure Meeting Maker to launch on startup. See 
“Launching Meeting Maker at Startup” below.

Launching Meeting Maker on Windows
From the Windows Start menu, select Programs > Meeting Maker > 
Meeting Maker.

The Welcome to Meeting Maker dialog box appears.

Launching Meeting Maker on a Macintosh
Double-click the Meeting Maker Calendar icon.

Tip: If you did not create an alias during install, the default 
Meeting Maker icon is located in HD:Applications:
Meeting Maker:Meeting Maker Calendar.

The Welcome to Meeting Maker dialog box appears. 

Launching at Startup on Windows
To configure Meeting Maker to launch at startup create a 
Meeting Maker shortcut in the startup folder.

1. In the Meeting Maker installation folder, create a shortcut to 
Meeting Maker Calendar.

Tip: The Meeting Maker Calendar application is mm.exe located 
in C:\Program Files\meetingmaker\mm.exe.

2. Drag the shortcut into the Start > Programs > Startup menu.

Meeting Maker will launch automatically when you start or restart 
your computer.

Launching at Startup on Macintosh OS X
To configure Meeting Maker to launch at startup add a Meeting Maker 
Calendar to your system preference login list.

1. Click the Login icon in the OS X System Preferences window.

The Login window appears.

2. Click Add.

The Open window appears.
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3. Navigate Meeting Maker Calendar installation folder, 
and click Open.

Meeting Maker Calendar appears in the Login Items list of the 
Login window.

Tip: The Meeting Maker Calendar application is 
Meeting Maker Calendar located in 
HD:Applications:Meeting Maker:
Meeting Maker Calendar.

4. Close the Login window

Meeting Maker will launch automatically when you start or restart 
your computer.

Configuring Meeting Maker Calendar
After installation, you must establish communication between 
Meeting Maker Calendar and the Meeting Maker Server before you 
can sign in initially. 

Obtain this information from your Meeting Maker administrator:

Network protocol

Meeting Maker server DNS name or IP address 

Meeting Maker server for sign in

To configure Meeting Maker Calendar

1. Launch Meeting Maker Calendar.

The Welcome screen appears.

2. Click Select.

The Select Server dialog box appears.

3. Select the network protocol (TCP or SSL) used by your 
Meeting Maker environment and click Configure.

The Host List window appears.

4. Enter the server IP address or DNS name, and click OK.

The server names appear in the Select Server pane of the 
Select Server dialog box.

Tip: To enable communication with multiple servers, enter each 
server IP address or DNS name, separated by a comma.
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5. Highlight the server, and click Select.

Meeting Maker displays the chosen server in the Welcome to 
Meeting Maker window. 

Configuration is complete. You can now sign in to Meeting Maker.

Signing In to Meeting Maker
Sign in to Meeting Maker after you configure Meeting Maker Calendar 
with the appropriate settings (page 16).

1. Launch Meeting Maker.

The Welcome screen appears.

2. Type your sign in name and password (case sensitive).

Note: See your Meeting Maker administrator for sign in 
and password.

3. Click Sign In.

You are ready to use Meeting Maker.

Working Offline
On signing in to Meeting Maker, you can click Work Offline rather 
than Sign In to use Meeting Maker with local data.

Sign in to Meeting Maker server once before you can work offline.

When you work offline, your calendar is not connected to the 
Meeting Maker server. 

Real-time or networked functions, such as viewing busy time or 
sending proposals, are disabled.

Schedule changes synchronize with the Meeting Maker server the 
next time you sign in.



18

Uninstalling Meeting Maker Calendar

Uninstalling Meeting Maker Calendar
You can uninstall Meeting Maker on Windows or Macintosh.

Uninstalling on Windows
Note: Do not uninstall Meeting Maker Calendar by deleting files 

manually.

To uninstall Meeting Maker Calendar:

1. Close open Meeting Maker applications. 

Open applications may cause incomplete uninstall.

2. From the Windows Start menu, select Programs > Meeting 
Maker > Meeting Maker Uninstall.

The Confirm Uninstall dialog box appears.

3. Click OK.

Meeting Maker completes the Calendar uninstall, and the 
Maintenance Complete dialog box appears.

4. Click Finish.

Uninstall is complete.

File and Folders not removed during uninstall
The files and folders that are not removed during uninstall contain 
important Meeting Maker data. Do not delete these files and folders if 
you plan to reinstall Meeting Maker on the same computer. 
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This table lists the folder and files that are not removed during 
uninstall. In addition, uninstall does not remove the entire directory 
structure beginning at C:\Palm\<user name>.

Manually delete these folders and files only if you are not 

Uninstalling on Macintosh
Do not uninstall Meeting Maker by deleting files manually.

To uninstall Meeting Maker:

1. Close open Meeting Maker applications.

Open applications may cause incomplete uninstall.

2. Double-click the Uninstall Calendar file.

The default location is HD:Applications:Meeting 
Maker:Uninstall

The Uninstall window appears.

3. Click Next.

The Uninstall Options window appears.

4. Select the desired uninstall option and click Next.

Note: If you choose to uninstall specific features, you can 
uninstall the Calendar application, online help, exporters, 

Folder/File Name Location

$<user name> 
folder

C:\Program Files\meetingmaker\mmclnt32

MMUSRPRF.MDB C:\Program Files\meetingmaker\mmclnt32

MMDATA.MDB C:\Program 
Files\meetingmaker\mmclnt32\
<user name>

mmcond.ini C:\Palm
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print layouts, or Conduits for Palm devices. After making 
your selections, click Uninstall.

5. Click Done.

Installing Meeting Maker on Windows
You can install Meeting Maker Calendar on Windows.

To install Meeting Maker Calendar:

1. Double-click the Setup.exe file.

Note: If you are installing Meeting Maker from a file server and not 
a CD, the install file name may be different. Check with your 
Meeting Maker administrator for details.

The Meeting Maker splash page and Meeting Maker Setup dialog 
box appear.

2. Click Next.

The Destination Location dialog box appears.

3. Select the desired location for the installation folder and click 
Next.

Note: If Meeting Maker detects the Palm Desktop software on your 
machine, the Installation Options dialog box appears. Select 
whether you want to install just Meeting Maker, just the 
Conduits for Palm devices, or both. You can use the Conduits 
to synchronize your Meeting Maker calendar with your Palm 
device.

Note: If any version of Meeting Maker exists on the machine to 
which you are installing, the Local Data Options dialog box 
appears. Select Move local Meeting Maker database to 
create a backup of your local data, Delete local Meeting 
Maker data to delete your local data, or Do not move or 
delete Meeting Maker local data to leave the data unaltered. 
If you do not move or delete your local data, Meeting Maker 
overwrites it with the latest data from the Meeting Maker 
server when you next sign in.
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The Installation Complete dialog box appears.

4. Select the desired readme and auto-launch settings, and click 
Finish.

The Installation Complete dialog box closes. Depending on your 
selected settings, Meeting Maker may launch, or display the readme 
file. Installation is complete.

Installing Meeting Maker on a 
Macintosh
You can install Meeting Maker Calendar on a Macintosh.

To install Meeting Maker on a Macintosh:

1. Double click the file Installer.

The Meeting Maker splash screen and Choose Install Folder 
window appear.

2. Select an install location, or accept the default location by clicking 
Next.

The Choose Alias Folder window appears.

Note: If Meeting Maker detects the Palm Desktop software on your 
machine, it prompts you to select which Conduits for Palm 
Devices you want to install. You can use the Conduits to 
synchronize your Meeting Maker calendar with your Palm 
device.

Note: If any version of Meeting Maker exists on the machine to 
which you are installing, the Backup Data dialog box appears. 
Select Copy Meeting Maker Data to create a backup of your 
local data, Delete Meeting Maker Data to delete your local 
data, or Do Nothing to leave the data unaltered. If you do not 
move or delete your local data, Meeting Maker overwrites it 
with the latest data from the Meeting Maker server when you 
next sign in.

3. Select the location where you wish Meeting Maker to create a 
Calendar alias and click Install.

Meeting Maker installs to the location you selected, and creates 
the desired alias. The Install Complete window appears.

4. Select the desired readme and auto-launch settings, and click 
Done.
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The Install complete dialog box closes. Depending on your 
selected settings, Meeting Maker may launch, create a desktop 
alias, or display the readme file. Installation is complete.

After You Install
Once you install Meeting Maker, you can launch and configure 
Meeting Maker. You can then sign in to your account and begin 
working.

Launching Meeting Maker
You can launch Meeting Maker Calendar on Windows or Macintosh. 
You can also configure Meeting Maker to launch on startup. See 
“Launching Meeting Maker at Startup,” below.

Launching Meeting Maker on Windows
You can launch Meeting Maker on Windows.

To launch Meeting Maker on Windows:

From the Windows Start menu, select Programs>Meeting 
Maker>Meeting Maker.

The Welcome to Meeting Maker dialog box appears

Launching Meeting Maker on a Macintosh

To launch Meeting Maker on a Macintosh:

Double-click the Meeting Maker Calendar icon.

Tip: If you did not create an alias for Meeting Maker on your 
desktop or dock at install, you can find the Meeting Maker 
icon by default at HD:Applications:Meeting 
Maker:Meeting Maker Calendar.

The Welcome to Meeting Maker dialog box appears. 

Launching Meeting Maker at Startup
You can configure Meeting Maker to launch automatically when you 
start up your machine.
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Launching at Startup on Windows
You can set up Meeting Maker to launch at startup on a Windows 
machine by placing a Meeting Maker shortcut in the startup folder.

To set up Meeting Maker to launch at startup on Windows:

1. In the folder to which you installed Meeting Maker, create a 
shortcut to Meeting Maker Calendar.

Tip: The Meeting Maker Calendar application is mm.exe. The 
default location is C:\Program Files\
meetingmaker\mm.exe.

2. Drag the shortcut you created into the Start>Programs>Startup 
menu.

Meeting Maker now launches automatically whenever you start or 
restart your machine.

Launching at Startup on Macintosh OS X

To set up Meeting Maker to launch at startup on Macintosh OS X:

1. Navigate to System Preferences in the OS X Apple menu.

The System Preferences window appears

2. In OS X.2 and below, click the Login icon in the Personal 
preferences pane. The Login window appears.
In OS X.3 and higher, select Accounts and then select Startup 
items. The Accounts window appears.

3. Click the Add button.

The Open window appears.

4. Navigate to the folder where you installed Meeting Maker 
Calendar, and click Open.

Meeting Maker Calendar appears in the Login Items or Startup 
Items list.

Tip: The Meeting Maker Calendar application is Meeting 
Maker Calendar. The default location is 
HD:Applications:Meeting Maker:Meeting 
Maker Calendar.

5. Close the Login window.

Meeting Maker now launches automatically whenever you start or 
restart your machine.
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Configuring Meeting Maker Calendar
After you install Meeting Maker Calendar, you must configure it to 
find the Meeting Maker Server before you can sign in. You must select 
a network protocol, enter the DNS name or IP address of your server 
machine, and select a Meeting Maker server to sign in to. Your 
Meeting Maker administrator can give you this information.

You only need to configure Meeting Maker once. After that, you can 
just enter your sign in name and password to sign in.

To configure Meeting Maker Calendar:

1. In the Welcome to Meeting Maker dialog box, click Select.

The Select Server dialog box appears.

2. Select the network protocol (TCP or SSL) used by your Meeting 
Maker environment and click Configure.

The Host List window appears.

3. Enter the IP address or DNS name of your server machine, and 
click OK.

Meeting Maker closes the Host List window, and displays Meeting 
Maker Server names in the Select Server pane of the Select Server 
dialog box.

Note: If your environment has multiple servers, enter all the servers’ 
IP addresses, separated by commas, to allow your server to 
communicate with others.

4. Select your server from the Select Server list and click Select.

The Select Server dialog box closes. Meeting Maker displays the 
chosen server in the Welcome to Meeting Maker window. 
Configuration is complete. You can now sign in to Meeting Maker.

Signing In to Meeting Maker
After you configure Meeting Maker once, you can sign in to your 
account.

To sign in to Meeting Maker:

1. In the Welcome window, enter your sign in name and password.

Note: Meeting Maker passwords are case sensitive.
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Tip: If you do not know your sign in name or password, contact 
your Meeting Maker administrator. Your name may already 
appear in the Welcome window.

2. Click Sign In.

Meeting Maker signs you in to your account. 

After you sign in, you can begin working with Meeting Maker.

Working Offline
On signing in to Meeting Maker, you can click Work Offline rather 
than Sign In to use Meeting Maker with local data.You must sign in to 
the Meeting Maker server at least once before you can work offline, or 
you will have no local data to work with.

When you work offline, your calendar makes no connection to the 
Meeting Maker server. You cannot use any of the real-time or network 
functions of Meeting Maker, such as viewing busy time or sending 
proposals, while working offline.

Meeting Maker sends any schedule changes or events you create to the 
Meeting Maker Server the next time you sign in.

C H A P T E R  2

Installing Meeting Maker Conduits 
for Palm Devices

This chapter contains information on installing the Meeting Maker 
Conduits for Palm devices when you install Meeting Maker Calendar. 
You can distribute this information to any users in your environment 
who plan to synchronize Meeting Maker with a Palm device.

Topics include:

Overview

System Requirements

Installing the Palm Desktop software

Installing Meeting Maker with Conduits
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Overview
To synchronize your Meeting Maker data with your Palm device, 
install the Palm Desktop software on your computer first. Then, install 
the Meeting Maker Calendar on your computer.

Remember this important information:

After you install the Palm Desktop software, the Meeting Maker 
Calendar installer prompts to you install the Conduits.

before you begin
Make sure you can synchronize to the Palm device

Sign in to Meeting Maker once before synchronizing.  

Meeting Maker attempts to populate your configuration 
information. If you were not the last person to sign in to 
Meeting Maker, you must configure your synchronization options. 

You can choose to configure your synchronization actions to 
determine how Meeting Maker synchronizes with your Palm 
device. 

For information on configuring and using the Meeting Maker 
Conduits, see the Conduits for Palm Devices online help, accessible 
from the Meeting Maker Calendar Help menu.

Using Intellisync
If your environment uses Intellisync for Meeting Maker, you can 
synchronize Meeting Maker with these devices:

Windows CE devices

Microsoft Outlook

Blackberry devices

Note: For information on installing and configuring Intellisync for 
Meeting Maker, refer to the Getting Started with Intellisync 
for Meeting Maker.
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System Requirements
Verify that your computer meets the installation requirements 
described in You must meet the Calendar requirements outlined in 
Chapter One of this guide in order to synchronize a Palm device with 
Meeting Maker. See “Meeting Maker Calendar Requirements” for 
more information.
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Installing the Palm Desktop Software
To synchronize Meeting Maker to your Palm handheld device install 
the Palm Desktop software. Refer to the Palm Desktop documentation.

Remember these important facts:

If you installed Meeting Maker first, you must re-install Meeting 
Maker Calendar after you install the Palm Desktop software.

You can perform a custom install for the Conduits rather than 
re-installing the entire Meeting Maker Calendar.

If you are using a Handspring Visor, you must install the 
Handspring version of the Palm Desktop software.

You can download the latest version of the Palm Desktop software 
for Windows or Macintosh this site:

http://www.palm.com/support/downloads/

If this link does not work, go to http://www.palm.com and 
navigate to the downloads page.

Once you install the Palm Desktop Software, install 
Meeting Maker with the Conduits.

Installing Meeting Maker with Conduits
The Meeting Maker conduits for Palm OS handheld devices install 
as part of the Meeting Maker Calendar installation.

You must install the Palm Desktop software before you install 
Meeting Maker. 

Meeting Maker prompts you to install the Meeting Maker Conduits 
during installation only if it detects the Palm Desktop software. You 
also should synchronize to the Palm Desktop software first before 
synchronizing with Meeting Maker for the first time.

Note: By default, Meeting Maker installs the To Do conduit and the 
Date Book conduit. If you want to install the Address Book 
conduit, or don’t want to install the To Do or Date Book 
conduits, you can change the selected options at installation.

If you have already installed Meeting Maker but not the Palm Desktop 
software, you must re-install Meeting Maker after installing the Palm 
Desktop software. You can choose to install only the Conduits rather 
than re-installing the entire Meeting Maker Calendar.
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Note: Your Meeting Maker administrator can choose to not enable 
the install of the Meeting Maker Conduits for network 
installations. In this case, you must get a version of Meeting 
Maker Calendar that includes the Meeting Maker conduits 
from your administrator.

After you install Meeting Maker with the Conduits, you can configure 
your synchronization to determine how to synchronize each conduit, or 
accept the default configuration and immediately synchronize your 
Meeting Maker data to your Palm device. In some cases, you may need 
to configure synchronization manually before synchronizing.
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C H A P T E R  2

Meeting Maker Calendar Quickstart

This chapter contains information about beginning to work with 
Meeting Maker Calendar. It also contains information on how to 
access more detailed instructions from the Meeting Maker Calendar 
online help system.

Topics include:

Overview

Introduction to Meeting Maker Calendar

Beginning Work With Meeting Maker 

Accessing Meeting Maker Online Help
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Overview
Once you have installed and configured Meeting Maker, you can sign 
in and begin to work with your calendar. You can control the Meeting 
Maker calendar view, propose meetings, schedule activities or banners, 
and perform other tasks. 

You can find advanced information in Meeting Maker’s online help 
system.

Introduction to Meeting Maker Calendar
When you sign in to Meeting Maker Calendar, the Main Window and 
the Proposals Window appear. The Main Window, Meeting Maker’s 
primary work area, shows the Daily View with one week displayed by 
default.

Proposals Window

Calendar View 

Meeting Maker Menu
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The Main Window
The Main Window contains two basic elements, the calendar view and 
the task bar. 

The calendar view can display your calendar in a number of different 
ways, including:

The Daily View with one week displayed

The Daily View with one day displayed

The Monthly View

The Text View

The Group View

The Daily View
The day and date for each displayed day appear at the top of the Daily 
View. Just below is the banner area, where any banners you create 
appear.

The main portion of the Daily View displays activities you schedule, 
and meetings you schedule or accept. An hour ruler appears on the left 

Banner Area

Task Bar

Monthly Navigator

Daily View
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side of the Daily View, and a blue bar appears on the current day to 
mark the time.

Note: For more information on banners, activities, or meetings, see 
“Beginning Work with Meeting Maker,” below, or the 
Meeting Maker online help system.

The Meeting Maker Daily View first appears displaying its default 
setting, a five-day work week. 

The Task Bar
The task bar appears at the left side of your Main Window. It contains 
links allowing you to create meetings, activities, or banners, change 
your calendar view, and perform other common tasks.

Beginning Work with Meeting Maker
This section includes instructions on performing several common 
Meeting Maker tasks, including creating meetings and banners. For 
more detail on these tasks, or for other instructions, see “Accessing 
Meeting Maker Online Help,” below.

Proposing a Meeting 
Meeting Maker Calendar allows you to propose a meeting in any of a 
number of ways. Three of the most common are:

Click Create Activity/Meeting on the Task Bar

Select New Activity/Meeting from the File menu

Drag in your Daily View to create an activity, then click Invite 
Guests to turn the activity into a meeting 

To propose a meeting from the Task Bar:

1. In the Task Bar, click Create Activity/Meeting.

The Activity window opens. 

2. Enter a title for the meeting, and an agenda if desired.

3. Click the Guests tab.

The Guests tab opens. The busy time grid displays the meeting as 
a blue rectangle.

4. Click Edit List to add guests.
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The Add Guests to Meeting dialog box appears. 

Tip: The left pane displays available users, resources, locations, 
groups, and contacts. The right pane displays current meeting 
guests. A pulldown menu above the left pane allows you to 
filter the available guest list for quicker guest selection.

5. In the left pane, select the guests you want to invite to the meeting.

The guests appear highlighted.

Tip: You can invite resources and locations as well as human 
guests, booking them for the meeting. You can select multiple 
guests at once using system standard multi-select methods.

6. Click Required, Optional, CC, or BCC, depending on the desired 
guest type.

The guests appear in the right pane with icons indicating guest 
type and availability.

Tip: You can click Get Info to view information about a guest, or 
Search to find a guest.

7. When you are done adding guests, click OK.

The Add Guests to Meeting dialog box closes. The guests you 
added appear in the busy time grid.

Tip: Each guest’s row in the busy time grid displays the guest’s 
busy time in red, free work hours in white, and time outside 
work hours in blue. The Required row shows the combined 
free and busy time of all required guests.

8. If desired, drag or resize the blue meeting rectangle in the busy 
time grid to a time when all your guests are free.

9. Click Create Meeting.

Meeting Maker sends the meeting invitation to your guests and 
places the meeting in your calendar.

Note: If any of your required guests are not free at the time of the 
meeting, a message appears informing you and asking if you 
want to continue. If a requested resource or location is not 
available at the time of the meeting, Meeting Maker may not 
allow you to send the meeting until you reschedule the 
meeting or remove the resource or location from the guest list.



22

Accessing Meeting Maker Online Help

Creating a Banner
You can create banners to mark single or multi-day events in your 
calendar that have no associated time. You can use banners to mark 
vacation time, travel time, project schedules, birthdays, and other 
important dates or periods. 

You can create a banner in any one of three ways:

Click and drag in the banner area of the Daily View

Click Create Banner in the Task Bar

Select New Banner from the File menu

The simplest way to create a banner is to drag in the banner area at the 
top of your Daily View.

To create a banner:

1. In the Daily View, drag in the banner area on the desired banner 
start date.

A shaded rectangle appears.

2. Drag the rectangle until it spans the days you want to mark with 
your banner.

The banner appears in the banner area with a blinking cursor.

3. Type a title for the banner and press Enter (Return on a 
Macintosh).

The banner appears with the title you entered. 

Accessing Meeting Maker Online Help
You can access the Meeting Maker Calendar online help system for 
further and more in-depth information on using Meeting Maker.

To access Meeting Maker online help:

From the Help menu, select Contents.

Meeting Maker displays the Calendar online help.
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C H A P T E R  3

Meeting Maker HTML Calendar

This chapter contains introductory information about Meeting Maker 
HTML Calendar. It also contains instructions on how to access more 
detailed information from the Meeting Maker HTML Calendar online 
help system.

Topics include:

Overview

Signing In to HTML Calendar

Beginning Work With HTML Calendar 

Accessing HTML Calendar Online Help
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Overview
If your environment uses HTML Calendar, you can sign in to your 
Meeting Maker account from any web browser without installing any 
Meeting Maker software.

You can find advanced information in HTML Calendar’s online help 
system.

Signing In to HTML Calendar
You can use any web browser to access HTML Calendar. 

If your environment uses HTML Calendar, your Meeting Maker 
administrator can provide you with the URL to access HTML 
Calendar. Entering the URL in your web browser displays the HTML 
Calendar sign in screen. 

To sign in to HTML Calendar:

1. In the Sign In window, enter your sign in name and password.

Note: Meeting Maker passwords are case sensitive.

Tip: If you do not have a sign in name or password, contact your 
Meeting Maker administrator.

2. From the Server dropdown menu, select the server on which your 
account resides.

Tip: If you do not know your server, contact your Meeting Maker 
administrator. If only one server appears in the menu, use that 
server.

3. Click Sign In.

Your web browser displays HTML Calendar.

Note: HTML Calendar displays your schedule in your home time 
zone, or Work Hour Time Zone. If you are traveling outside of 
your usual time zone, your schedule does not appear in local 
time, and your reminders do not come in at local time.

After signing in, you can begin working with HTML Calendar.
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Beginning Work with HTML Calendar
When you sign in, the HTML Calendar displays the main window, 
which consists of three elements:

The Task Bar, at the left of the main window, which contains links 
allowing you to create meetings, banners, or activities, or to 
perform other advanced Meeting Maker tasks.

The Calendar View, which displays your schedule, and can be 
viewed in a number of different ways. The Calendar View opens 
displaying the Daily View by default.

The Proposals Panel, below the calendar view, which shows a list 
of proposed meetings received from other users, a list of meeting 
proposals you have sent to other users, and a list of proposals you 
have declined.

For more detail on these tasks, or for other instructions, see “Accessing 
HTML Calendar Online Help,” below.

Accessing HTML Calendar Online Help
You can access the HTML Calendar online help system for further 
information on calendar procedures, calendar preferences, display 
controls, and other advanced tasks.

To access HTML Calendar online help:
In the task bar, click Find help.

Meeting Maker displays the HTML Calendar online help.
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